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Project management timeline template google sheets

Skip customer relationship management (CRM) content helps sales teams track leads, contacts, and opportunities. While dedicated crm software includes additional functionality, you can easily set up CRM on Google Sheets to monitor the most important information if you're just getting started. We will show you how in only seven simple steps. Of course, if you want to make more
than google sheets records, Salesforce Essentials is a CRM that offers an easy-to-use interface, intuitive mobile app and 360-view of any deal and contact. This small business-optimized CRM is $25 per user, per month, and you can try it out for free in 14 days. Visit the Salesforce Free CRM Spreadsheet Template, set up the CRM Google Sheets template to keep track of
opportunities for leads, contacts, and sales, it doesn't have to be complicated or scary. In addition to introducing you to the steps to set up your own below, we included a free template that you can use to start managing contacts and deals. We created this template in Google Sheets, but you can easily follow the same steps to create a similar feature in Excel. Download the
spreadsheet template for a free CRM spreadsheet template To set up crm in a spreadsheet, follow these seven steps: 1. Define the sales process Before you start creating CRM using a spreadsheet, take some time to determine your sales process, including what you want to track, and decide what information is important for your trades and contacts. This will save you time and
effort later if you have already defined the process and planned how your contacts will move through the sales channel. Several aspects of the process to consider include: Decide how contacts should be tracked Create a contact tracking sheet that can be either leads or customers. Some CRM software provides the ability to track each of them individually, which can be useful in
sorting out who is a customer who is a partner and who is still in the lead process. For our Google Sheets CRM template, it's easier to simply use a column to specify the contact type than copying and pasting. Consider how offers will move through the transaction process are the sales opportunities that you are trying to close. I recommend you create a separate sheet in your
spreadsheet workbook to track transaction progress. Think about how to move trades through the sales process and how to identify different stages. The spreadsheet in Google Sheets is useful for tracking the progress of a transaction, but there are also a few simple CRM systems that can save you time and aggravate the system setup itself. Specify your process stages pipeline
process for both leads and transactions, you should consider the sales stages that you will track in your CRM. These are the different steps in the pipeline that help move a lead from the initial opening by closing a deal. For example, you can use the following stages to Leads and trades: Incoming inquiry: This is the stage where you first receive a request from a lead. Maybe they
filled out a form on a website or sent you an email. You still don't know if they're suitable, but they're interested. Qualified lead: Use this stage to represent leads that best match your target customer and are most likely to become customers. You have additional information from a direct contact or because the customer has gone through your marketing funnel. Consultation: This is
the moment you have a sales-focused needs assessment to determine the specific needs you have and whether you'll be able to meet them with your product or service offer. Suggestion: This is the stage where you created and submitted a sales offer to your lead based on the needs assessment you've conducted. Contract: Use this stage to indicate when your contacts have
accepted your offer and negotiate and prepare a contract for the business. Won or lost: This is usually the last stage of the sales process and shows whether a lead has become a customer or not. Identify leads Leads You should also use your spreadsheet to keep track of where your potential customers come from, so that you can make informed decisions about where to invest
your future marketing efforts. Specifying whether a lead or sales opportunity came from a personal reference, online ad, or lead generation campaign can help you track and track your marketing efforts and assess which efforts are most effective in generating a new business. 2. Choose your spreadsheet software An important factor to keep in mind is which spreadsheet software
to use. It may not seem like a big deal, but the spreadsheet you choose really has questions, especially if you need sharing features or advanced formatting. Two of the most popular spreadsheet suggestions are Google Sheets and Microsoft Excel, but there are also Apple numbers for Mac users. You can check our G Suite vs. Office 365 article for more information on how the
two compare. About this guide on how to use Google Sheets to present each of the steps, as it can be used free of charge by anyone with a Gmail address. If you are using Excel, the steps are the same, and you can just adjust them to match small differences in Excel in the nomenclature. Besides, if you are an Excel user, you can just click the template link above and download it
as Excel File. Downloading the Google Sheets template or Google Excel Tables is part of g suite's collection of browser-based productivity software and is available for personal use by anyone has a Gmail account. One of Sheets' strongest features is real-time collaboration and sharing functionality, allowing multiple users to view and edit the same document at the same time.
This is ideal for teams who want to create a central CRM through shared shared easily accessible to all users on all their devices. Microsoft Excel is the most used spreadsheet software by companies for everything from accounting to human resources management (HR). It is available as a desktop app for Windows and Mac computers, as well as on mobile devices. It is also
available as a browser application called Microsoft Excel Online. Using Excel to create a spreadsheet allows you to take advantage of some of the advanced features, such as data visualization tools and 2D maps. Numbers Another option for Mac users to consider is the number from Apple. The numbers are available as a desktop, iPad and iPhone app, as well as browser-based
software, and include real-time cloud sharing features via iCloud. This allows users to keep their spreadsheets in sync between devices and between shared users. Numbers are easy to use and feature many of the same advanced calculations as Excel, but it's only available on MacOS and iOS. 3. Create your spreadsheet The next task is to set up your spreadsheet and be ready
to configure for use as CRM. We'll look at the steps that will make you start adding contact information in a minute, but before we do, there are a few cleaning items that will make it easier to use your spreadsheet. Decide where you'll get access to data One of the first decisions you need to make is whether you'll be working primarily with your file on your desktop or whether you'll
want to access it from anywhere, such as a remote office or smartphone. The choice of which is best depends largely on whether you share crm with other team members or work on it yourself. Excel comes as a standalone desktop app, as well as a mobile and browser-based app through an Office 365 subscription. On the other hand, Google Sheets is only available through the
cloud. If you share access with others, you'll find that the online version of Excel or Google Sheets is a better choice. Create your tables Most spreadsheet software applications allow you to create multiple worksheets with workbooks (not to be confused with Google Sheets, the program) within a single file. This is especially useful for creating CRM in a spreadsheet, as you can use
different sheets to track contacts and trades. We recommend setting up two sheets in your workbook to keep track of your contacts and transactions separately. Use multiple sheets to keep the data separate number 1: Your contacts are the people you interact with and communicate with. They can be new leads, existing customers, partners, or even referral sources. You will use
this sheet to keep track of their information, as well as to make notes about your interactions and conversations. Sheet Number 2: Offers Sheet deals are used to track sales opportunities that represent specific trades that you are trying to close and that move through your sales process. Some industries, such as cloud-based cloud-based as a service (SaaS), you may not
necessarily track trades, but rather move waters through the process of growing a lead to close the sale when they sign up. However, many industries sell either products or services (or both) and need a way to track the sales process. Set sharing preferences depending on whether you're only working on this CRM or using it with a team, you'll want to set sharing preferences. One
of the advantages of Google Sheets and Microsoft Excel Online is that multiple team members can work on the same file in real time, making collaboration easy and intuitive. This ensures that all contact information is up to date, giving sales team members the most up-to-date information to work with. In Google Sheets, sharing is simple by clicking on the blue Share button in the
upper-right corner of the interface. You can give specific individuals access to files, or if you're a Business G Suite client, you can allow all individuals in your organization to interact with the file, provided they share the same domain in an email and user profile. Set sharing preferences Set security permissions and users Because you will store personal and business information on
your contacts, security is an important consideration. G Suite and Office 365 use 128-bit automatic encryption to safely store client data and HTTPS to transmit data to and from the server. Both options are also hipaa compatible when using browser-based or mobile applications. In addition, sharing features of both allow you to restrict access to specific individuals. 4. Named
column headings now, after you have set up your spreadsheet file, you need to create headers for each column. You'll use columns for the different types of information you want to keep track of each contact and transaction. The lines in your spreadsheet will store separate records. One of the reasons you think about the headers you'll use is that each is a data point that you'll be
able to use later to sort, search, and find specific records. Contact sheet headers We recommend that you use the following headers for your contact sheet, although you can change it to add additional types of information that you need to track. This list will help you make sure you take away the information you need to contact your leads and customers and move them through
the sales process. The headers we have used in our template are as follows: Contact: Each transaction must be linked to a person, whether a lead or an existing customer. Email: This must be the email for the primary contact. Phone: This must be the primary or primary phone number for the contact. Company: Use this company or account to which the transaction is linked. Title:
It's often helpful to know where your contact fits into the overall organization, especially when you need to know whether or not you're likely to make decisions. Address: This is where you will keep track of the postal address of the Contact. Contact type: Since you can use this sheet to keep track of several different types of persons you are communicating with, you will want to
make sure that they are a lead, customer, or other type of contact. Stage: Depending on how you acquire new leads, you can use this field to keep track of where the contact is in the lead enveloping process. Source: Knowing where your new customers come from helps you make better sales and marketing decisions, so use this field to keep track of where each contact came
from. Last Contact: You'll want to keep track of when you last communicated with a contact, so use this field to update the date each time you send an email or talk to a contact. Notes: Here he makes notes about conversations or other communication you have with the contact, as well as all the necessary steps for action. This ensures that you will always have up-to-date
information the next time you or someone on your team communicates with them. Owner: Use this field to indicate who is responsible for this transaction. Named contact sheet headers Page Headers with suggestions similar to the contact headers above, we recommend that you use the following headers for the handout sheets. As before, feel free to add additional headers
based on the information you need to move trades through the sales process, but they need to make sure you have captured and tracked the most important information. We have used those in the template found above: Deal Name: This is what you will call the deal (for example, Bob Cleaning Website). Use names that you'll quickly be able to find and associate with specific
sales opportunities. Transaction Description: In addition to the name, it may be useful to include a brief description of the transaction so that you and your team can specify the scope of the opportunity to sell. Transaction value: This represents the estimated or suggested value of the transaction. Depending on the types of products or services you sell, this may be the one-off price
or represent the value of the contract distributed over time. Transaction category: If you sell multiple types of products or services, you can use this to easily identify the type of opportunity to sell. In the example I mentioned, the category can be a website design. Transaction Processing Stage: Using the stages you defined earlier, you can use this field to easily specify and
determine where each sales opportunity is located in the sales process. Contact: Each transaction must be linked to a person, whether it's a lead or an existing customer. Email: This must be the email for the primary contact. Phone: This must be the phone number for the main contact. Company: Use this field for the company or account to which it is linked Source: Knowing
where your new customers come from helps you make better sales and marketing decisions, so use this field to keep track of where all the deals came from. Probability of closure: If you want to give yourself a picture where trades are most likely to close, use this to track the probability rate that any sales opportunity will close. This allows you to calculate the current value of each
transaction. Last contact: When interacting with a transaction contact, update this field so that you can later see which trades need your attention based on how long it has been since you got in touch. Notes: When talking to a contact about a deal, make notes here about the conversation, progress, and all the necessary steps to act. This ensures that you will always have up-to-
date information the next time you communicate or someone else on your team. Owner: Use this field to indicate who is responsible for this transaction. Name your sheet headers with arrangement 5. Import existing data, regardless of what you've used to keep track of your contacts so far, you'll want to move all contact information to your new spreadsheet so you can start using it
to close more bids and convert more leads to customers. There are several ways to do this depending on where the contact information is stored at the moment. Here are a few of the most common ways to import your information: Manually enter data depending on the number of contacts you have, one of the simplest ways to fill in your new CRM spreadsheet is to enter the
contact information in the spreadsheet manually. You will simply enter one contact record or give away for each line of the spreadsheet. If you only have multiple contacts so far, this is a manageable way to get your information in CRM with a minimum amount of work. Import from email most likely, until now, you are after traces of all your contacts using your email. This works well
when you only have a small number of contacts or trades, but you may get a striking as that number grows, which is probably why you're looking for a better solution. Many OF THE MOST COMMONLY USED SAIs offer direct integrations in Outlook or Gmail, but for this guide we want to talk about how to get this information out of our inbox and into our brand new spreadsheet. If
you're using Gmail, you can simply export your contacts to a CSV file, open the excel or Google Sheets file, and then copy the records to your new spreadsheet. For many users, this may be the easiest option, but if you have a large number of contacts, the good news is that there are ways to make the process more automated. For example, Mailparser allows you to export emails
and translate them to your spreadsheet. It's a paid service, but they have a 14-day free trial during which time you can export a batch of files and send them to your new spreadsheet. Import from other software If you have previously used some type of contact management tool as an address book your Outlook contact list, normally, you can export your contacts as a CSV file that
can be opened in Excel or Google Sheets. This also applies if you use tools like Mailchimp or Constant Contact and want to move your contacts to a CRM spreadsheet. Pro tip: If you've with one of these tools, sometimes it's easier to take the first step and export your contacts to CSV. Then open this file in Google Sheets or Excel, and change the resulting spreadsheet to match
the format described above. This way you'll have the contact information already in your CRM, and then you can add and move columns if necessary. 6. Create Automation &amp;&amp;quot; &amp;quot; Integration One of the most powerful advantages of spreadsheet software is that you can use it not only to store information, but also to interact with your data. This turns your
CRM from a list of names into a tool that you can use to be in the best version of the sales process and win more new business. Here are a few ways you can set up your CRM spreadsheet to work for you: Adding conditional formatting to conditional formatting allows you to create rules based on information in a cell. For example, you can set a rule that turns the cell background
red if the date in the Last Contact column is more than four weeks ago, warning you that you need to contact that lead. In fact, we set up the sample template to do just that. Add conditional formatting to sheets However, if you want to know how to do it yourself, follow these simple steps: 1. Select the cell, row or column you want to format. For your CRM, you'll most likely want to
select a column, since all the information in each column is a specific type of information. 2. Right click your selection or click the Format menu, and select Conditional Formatting. 3. Then you will be given a list of the rules attached to your selection, as well as the Add New Rule option. 4. Then in the box called apply to range, you need to see your selection. If not, just add the
range of cells that you want to add formatting to. 5. In the Format Cells dialog box, if... select the condition that must be met in order to apply the formatting. This can be linked to a date or other value. You can even add a condition for a field that is empty or if it contains a certain type of text. 6. Finally, select the formatting you need to apply if the condition you have applied is met.
You can change the color, font, or style in a cell. Use data validation lists Another useful type of automation is to add data validation, which means that only certain types of data can be added to a cell or range. In the sample template, we used this function in the Contact type and Stage columns to limit the information to specific lists. The setup process is similar to adding
conditional formatting and helps keep your CRM data clean and organized so you can more easily sort and according to the contact information. Data validation in Google Sheets To add data validation in Google Sheets, just follow these steps: 1. Select the cell, row, or column to which you want to add data validation. Again, you will most likely want to select a column, since all the
information in each column is a specific type of information. 2. Right-click the or click the Data menu and select Validation Data. 3. The selection you have selected must be specified in the Cell Range field. If not, you can add it manually. 4. Select the type of validation you want to use. We chose a list of items. 5. Enter the list you want to use for your drop-down menu, each term
being separated by a comma. 6. To make sure that only your list of terms can be used, select the Reject input option in the Invalid data box. 7. Save changes. Integrate with other tools after you've set up crm, you can use third-party automation tools to help you keep your CRM data up to date while generating new leads. For example, if you use a lead generation tool like
Mailchimp, Zapier will send new subscribers who fill out your subscription form on your website directly in your spreadsheet as new lines. Zapier actually facilitates what allows you to apply fields directly from the form to the corresponding fields in the CRM spreadsheet. Integrate Google spreadsheets with Zapier 7. Generating crm spreadsheet reports allows you to keep your
information organized and allows you to create basic reporting using the features already mentioned, as well as other features in Google Sheets and Excel. Now we'll talk about a few ways you can use your data to facilitate the sales process by providing you with reports and statistics about your contacts. Sort by columns your CRM data can be sorted by columns, allowing you to
keep data organized according to any characteristic or type of contact information. For example, you can keep your trades and contacts in alphabetical order, line by transaction value, or in the order of the latest contacts. To sort the data, move your mouse over the top row and click the selection arrow that appears. Scroll down the menu and choose whether to sort the column in
ascending or descending order. Using filter views in filtering filters in Google Sheets is an extremely powerful tool that allows you to create individual views based on specific conditions or values. As an example, you can create a view that shows leads you haven't contacted in the last month, or a view that shows you all trades over $5,000 that are likely to close at least 80%. With
filtered views, you can generate reports that give you an idea of your contacts that you can act on. Set filters by selecting the Data menu &gt; Filter views &gt; Create a new filter view. Then you can select the columns you want to filter and the way you want your data to appear. remove from the view any records that do not meet the conditions you set. FAQ Which spreadsheet tool
should I use? The specific spreadsheet that's best for your business depends on several factors. If real-time sharing and collaboration are the most important, Google Sheets is the best choice. If computer compatibility and advanced performance features are the most important, most important, is the best choice. When should I move to CRM? The decision to get involved and
sign up for full-featured CRM depends on many factors. However, generally speaking, if you manage more than 50 contacts or more than five trades at a time, it probably makes sense to start browsing CRM-specific software. If you are on a budget, several OCD offer plans for eternity. What is the difference between spreadsheet software and database? A table is a collection of
records organized into rows and columns of cells that can be sorted and filtered. Additionally, tables allow calculations and other formats to be applied to one cell or range of cells. The database software also supports information collection, but the main difference is that they are relational – meaning you can connect different types of data to establish a connection between them.
For example, you may have a contact in your database and link this record to a sales opportunity or account. The database monitors the connection and keeps the data connected behind the scenes. Spreadsheets allow for some possibilities for linking cells and sheets, but are limited in their ability to establish links between different record types. Bottom Line: Google Sheets like
CRM for companies that want to control their contacts and close more businesses, creating CRM in a spreadsheet can help optimize their sales communication efforts. While spreadsheet software like Google Sheets doesn't have the advanced features found in specialized CRM small business software, it can be a cheap, no-frills way to move away from inbox and toward a more
productive sales process. For companies ready to make the leap to special CRM software, we recommend Salesforce Essentials as it offers contact and transaction management, email tracking and customer support features for just $25 per user per month. Visit their website today to start your 14-day trial. Visit Salesforce
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